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Disclaimer 
 

HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE CERTAIN 

INHERENT LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD, 

SIMULATED RESULTS DO NOT REPRESENT ACTUAL TRADING. ALSO, SINCE 

THE TRADES HAVE NOT ACTUALLY BEEN EXECUTED, THE RESULTS MAY 

HAVE UNDER- OR OVER-COMPENSATED FOR THE IMPACT, IF ANY, OF 

CERTAIN MARKET FACTORS, SUCH AS LACK OF LIQUIDITY. SIMULATED 

TRADING PROGRAMS IN GENERAL ARE ALSO SUBJECT TO THE FACT THAT 

THEY ARE DESIGNED WITH THE BENEFIT OF HINDSIGHT. NO 

REPRESENTATION IS BEING MADE THAT ANY ACCOUNT WILL OR IS LIKELY 

TO ACHIEVE PROFITS OR LOSSES SIMILAR TO THOSE SHOWN. 
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Software License Agreement 
 

This is a legal agreement between you, the licensee, and Adaptrade Software for the Market 

System Analyzer software, including associated documentation. By installing, copying, or 

otherwise using this software, you agree to be bound by the terms of this agreement, as stated 

below. 

 

This software is protected by copyright and intellectual property laws, including international 

laws and agreements. This software is licensed, not sold. The terms of this license agreement 

include the following: 

1. The software may be freely distributed provided the installation executable is unaltered 

and distributed in whole.  

2. A single license may allow operation of the software only on the computer on which it is 

originally installed. To install the licensed version on more than one computer or to 

install it on a different computer, please contact Adaptrade Software for additional 

activation codes. Additional codes are generally free of charge for reasonable use. 

Regardless of how many copies are installed, a single license grants you the right to use 

only one copy at a time. 

3. This license agreement is not transferable.  

4. You agree not to hold Adaptrade Software liable for any losses or damages resulting 

from the use of this software.  

5. You agree not to reverse engineer or ñdecompileò any part or component of the 
software. 

6. The software is provided ñas is.ò While Adaptrade Software makes every effort to 

provide reliable software, free of defects, omissions, and errors, there is no guarantee 

that such defects, omissions and errors are not present in the software. You accept sole 

responsibility for verifying any calculations made by the software. 
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Chapter 1 
Quick Start 
 
 
 

The following steps outline the basic process of using Market System Analyzer (MSA) 3: 

 

1. Compile in a text file the trade data you wish to analyze. 

2. Open a new MSA file if one is not already open. 

3. Set the "Data Source" in MSA to your text file of trades or import or manually enter 

the trade data into MSA. 

4. Enter basic settings, such as whether the input data represent stocks or futures, 

starting account equity, margin, commissions, etc. 

5. Choose a position sizing method. 

6. Explore optional methods and analyses, such as dependency rules and equity curve 

crossover rules. 

7. Adjust the position sizing settings and rules to maximize trading performance. 

8. Use the Trade Size command for real-time position sizing if desired. 

9. Optionally create a portfolio by selecting two or more MSA files. 

 

Step 1 

If possible, the trade data should be compiled into a spreadsheet or text file in column format 

with one trade per line. At a minimum, MSA requires the profit or loss amount in dollars for 

each trade or, alternatively, the entry and exit prices. The order of the columns does not 

matter. Placing the trades in a text file allows you to use the Data Source command in the 

Trades menu to specify the file where the trades will be stored and read from. If you update 

the file with new trades, the market-system (.msa) file will be automatically updated as well. 

If you have multiple market-system files using the same data source (trades file), they will all 

be updated automatically if you change the trades file. Unlike in version 2, trades are not 

stored in the MSA file in version 3; they are stored in the trades file. 
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If all trades are the same size, the number of shares or contracts can be entered separately on 

the Analysis Setup window. Stock traders will want to include columns for the entry and exit 

prices; entry prices are used to calculate margin requirements for stock trading. If the data are 

entered into a spreadsheet, the spreadsheet file should be saved as a .txt or .csv file for use 

with the Data Source command or for importing. See Chapter 3, Input Data, Getting Data 

into the Program, for more information on compiling data for use in MSA. 

 

If all trades have the same trade risk, defined as the amount you'd lose per share/contract if 

the trade were a loss, you can specify the risk after importing the trade data by using the 

Specify Trades Risk command of the Trades menu. Trades risks are only necessary when 

using one of the position sizing methods that requires them, such as fixed fractional. 

 

Step 2 

When MSA 3 is opened directly (without an associated document), it opens a new market-

system document by default. If one is not already open, create a new market-system 

document by selecting New from the File menu and New MSA File from the submenu or use 

the New button on the tool bar. When a market-system (.msa) file is open and selected, the 

menus (File, View, Trades, Analysis, etc.) reflect the available options for market-system 

files. When a portfolio (.msaport) file is open, the menus will be different to display the 

different options available for portfolios. 

 

Step 3 

Once the trade data have been compiled in a text file, it's necessary to tell MSA the name of 

the file and what each column in the file represents. This is done using the Data Source 

command of the Trades menu. Click the Select New File button on the Data Source window 

to open the file dialog box, then select the file of trades and click Save. This will bring up the 

Trades File Format window, which should display the trade data read from the file. By 

clicking on each column heading, you can identify the contents of each column. Finally, 

click Ok twice to read the data into MSA. When you later save the market-system file from 

the File menu, the file specified using the Data Source command will be used to store the 

trades. When the market-system file is opened next time, the trades will be read from this 

file. 
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 An alternative method is to import the trades file. The basic process is the same as using the 

Data Source command, except that when you import the trades file contents into MSA, the 

file from which the trades are imported is not subsequently used to store the trades. When 

you save a market-system file without having previously selected a file in Data Source, MSA 

will prompt you to enter or select a file, which the program will use to store the trade data. 

  

If entering trades manually, use the Edit/Add  command of the Trades menu.  

 

 
 

This brings up the Edit/Add Trades window. Enter the data for each trade in the fields 

provided under "Add Trade..." If entry and exit prices are entered, it is not necessary to also 

enter the Profit/loss amount. Similarly, if the stop price is entered, it is not necessary to also 

enter the Risk amount. If a stop was not used with the trade, leave the risk and stop price 

fields blank. See Chapter 3, Input Data, Editing Input Data, for more information. 

  

After importing or entering the trades, save the data as a market-system (.msa) file using the 

Save command of the File menu. The market-system file will store the trade data in the text 

file specified under Data Source (Trades menu) as well as all program settings in the .msa 

file. Double-clicking on an .msa file will start MSA and open the selected file. 

 

Step 4 

Select the Setup command from the Analysis menu. On the Input Data tab, use the drop-

down list next to ñTrading Vehicleò to select either Stocks or Futures.  
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If selecting Futures, also enter the Point Value. The point value is used to calculate the 

profit/loss amount from entry and exit prices. For example, if an entry price for the E-mini 

S&P is given as 1204.75, the point value would be $50. If the same price were entered as 

120475, the point value would be $0.50. 

 

If all trades entered in step 2 were the same size and the size was not specified in the input 

data, the trade size can be entered in the field ñDefault Trade Size.ò 

 

On the Account Settings tab, enter the starting account equity and margin amount (if futures) 

or margin percentage (if stocks). If the trade data do not include commission and slippage 

costs, enter those costs here. Click Ok to save the settings and exit. 
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See Chapter 4, Basic Settings, for more information on the Analysis Setup window. 

 

Step 5 

Bring up the Position Sizing window by selecting ñPosition Sizingéò from the Analysis 

menu. Select one of the methods listed in the box on the left side of the window.  

 

 
 

Most methods have either one or two adjustable parameters. Enter each parameter value in 

the corresponding box. The Parameter Studies feature (see Chapter 7) is helpful in choosing 

values for the position sizing parameters. See Chapter 5, Position Sizing, for more detailed 

information. 
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Step 6 

Explore other analysis features and options of MSA listed in the Analysis menu. For 

example, selecting the Monte Carlo Analysis command performs a Monte Carlo analysis by 

randomly sampling from the distribution of trades. Try one of the trading rules under 

ñDependency Ruleséò Equity curve crossover rules can be applied using the Equity Curve 

Crossovers tab of the Position Sizing window. 

 

Step 7 

Finding the best combination of settings for any given set of trades is largely a matter of trial 

and error. Each setting is immediately reflected in the equity curve of the main chart and in 

the right-hand pane, which displays summary statistics that correspond to the displayed 

equity curve. For more detailed performance results, select Performance Statistics from the 

View menu (also see Chapter 12, Viewing the Results). The performance statistics combined 

with the shape of the equity curve can be used to determine if the chosen settings are 

acceptable. One possible scenario is to use MSA to optimize the position sizing method 

while limiting the analysis to a range of trades and saving the rest for out-of-sample testing. 

You could then select other rules, such as dependency rules or equity crossover rules, and 

verify the analysis with out of sample testing and Monte Carlo analysis. 

 

Step 8 

Once a good combination of settings has been found, use the Trade Size command of the 

Analysis menu to get the position size for any upcoming trades.  

 

 
 

Enter the current value of your account equity (and optionally the trade risk and market 

price) then press the "Calculate" button. The number of shares or contracts plus the required 

margin will be displayed for the next trade based on all current settings in the software. For 

stocks the required margin is the cost of the trade. For example, with no leverage (100% 

margin) and an entry price of $25, 200 shares of stock will cost $5000, which is the required 

margin for the trade. 

 

To keep the calculations up-to-date, make sure the trades file, as listed under Data Source, is 

up-to-date. For example, you could enter each new trade into the program using the 



7  
 

Edit/Add  command (Trades menu) or use the included WriteTrades function for 

TradeStation. The Trade Size command is described in more detail in Chapter 5, Position 

Sizing, Real Time Position Sizing. 

 

Step 9 

Once you've created more than one market-system (.msa) file, you can create a portfolio by 

opening a new portfolio (.msaport) file and selecting any number of market-system files. 

Create a new portfolio document by selecting New from the File menu and selecting New 

Portfolio  from the submenu. The available menus should change to include a Portfolio 

menu. Select Setup from the Portfolio menu or from the right-click menu and click the 

Market Systems tab. Use the Add Market System(s)... button to select any number of existing 

market-system (.msa) files that you've already created. On the Settings tab, enter your 

starting account equity. Click Ok to save your changes and exit. The resulting equity curve 

will display the combined result of all selected market systems, with the trades in order of 

exit date and including any rules and settings from the individual market-system files. 

 

 
 

Select Position Sizing from the Portfolio menu or from the right-click menu to bring up a list 

of each market system with its default position sizing settings. Double-click on any market 

system to change the position sizing method and/or parameters. By default, the settings are 

retrieved from the market-system file. To change a parameter value, change the Parameter 

Source to User Selected on the Position Sizing window then enter the new value in the space 

provided. 
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Equity curve crossover rules can be added to the portfolio from the Equity Curve Crossovers 

tab of the Position Sizing window. These rules are in addition to any equity curve crossover 

rules defined in the market-system file, which will still apply to the market system after it's 

added to a portfolio unless specifically turned off. You can turn off the equity curve 

crossover rules in the market-system files by checking the box labeled "Deactivate all 

crossover rules ..." on the Equity Curve Crossovers tab of the Position Sizing window.  

  

To add a dependency rule to the portfolio, select Dependency Rules from the Portfolio menu 

or from the right-click menu. These rules are in addition to any dependency rules defined in 

the marke- system file, which will still apply to the market system after it's added to a 

portfolio unless specifically turned off. The dependency rules for the market system can be 

turned off by checking the box labeled "Deactivate all dependency rules ..." on the Portfolio 

Dependency Rules window. 

  

If you change any settings in an individual market-system file, select Reload from the 

portfolio menu to update the portfolio file. 

 

 

To get help on any feature or command while using MSA, press F1 at any time. The Getting 

Started help screen can be displayed at any time by selecting the Getting Started Screen 

command from the View menu. 

 



Chapter 2 
Introduction 
 
 
 

Overview 
Market System Analyzer (MSA) will help you get the most out of your current approach to 

trading the markets. MSA is designed to uncover profitable patterns, optimize trade 

allocations, and avoid trades that have a low likelihood of success. 

 

MSA analyzes "market systems.ò A market system is defined as the combination of a 

financial market and a trading system or method applied to that market; for example, a 

moving average crossover system applied to the Euro market. MSA analyzes market systems 

in terms of the trades they generate. The program is designed to extract the maximum 

amount of information from the minimum amount of input data. Moreover, all analysis 

features in MSA are accessible from simple menu commands, making it easy to perform 

powerful analyses without any complicated programming. 

 

The analysis features available in MSA include: 

¶ 15 position sizing methods and several options for applying position sizing. 

¶ The ability to combine market systems into portfolios. 

¶ A randomization feature that lets you visualize the effect of trade order on trading 

performance. 

¶ Monte Carlo analysis to quantify the effect of trade randomization on trading 

performance. 

¶ A unique parameter studies feature that lets you plot position sizing parameters against 

any of eight performance measures. 

¶ Position sizing optimization so you can maximize your trading performance using any 

of the available position sizing methods. 

¶ Dependency analysis to determine if your trading system or method has a statistically 

significant tendency to form runs of wins or losses. 

¶ Dependency rules to exploit any trade dependency that may exist. 

¶ Significance testing to determine the likelihood that your trading system or method is 

inherently profitable. 

¶ A unique equity curve crossover feature with rules for modifying your trading based on 

crossovers of the equity curve with its moving average. 

 

In addition, Market System Analyzer enables you to: 

¶ Perform real time position sizing. 

¶ Import trades  from a text file. 

¶ Synthetically generate a series of trades from summary performance statistics. 

¶ Edit, add, or delete trades. 

¶ Export, copy, or print  trades or performance results. 

¶ Perform the position sizing optimization on a sliding window of trades, with automatic 

walk-forward testing. 

¶ Perform the dependency analysis on a sliding window of trades to uncover short-term 

dependencies. 

¶ Restrict the analysis to a range of trades, saving the rest for out-of-sample testing. 

¶ Work with your existing TradeStation systems. 
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¶ Format the chart: change fonts, line and bar colors, grid, title, etc. 

 

Market System Analyzer can be used for several different purposes: 

¶ As an educational tool. 

¶ To test and evaluate trading systems and methods. 

¶ For day to day trading decisions -- to decide whether to take an upcoming trade and, if so, 

how many shares or contracts to trade. 

 

The software is designed for both individual and professional traders. The familiar Windows 

interface makes the program easy to use, and detailed help files are available if needed to 

explain how to use each analysis feature. To get started, all you need is a list of profit/losses 

for the trading system or method you want to analyze. 

 

Whatôs New in Version 3 
The following information is intended primarily for those who are migrating from MSA 

Version 2. Version 3 was designed to encapsulate the functionality of version 2 while adding 

portfolio analysis. This was done by (1) adding a second file type for portfolios, and (2) 

allowing multiple windows/files to be open at the same time. In addition to files of type .msa, 

version 3 uses a new file type to represent portfolios. Starting in version 3.2, portfolios use the 

file type .msaport. In versions 3 prior to 3.2, portfolios had the file extension .msp. Current 

versions of MSA can open either .msp or .msaport files. 

 

The vast majority of features and operations pertaining to market systems remains the same in 

version 3 as in version 2. Working with .msa files and market systems in general is very 

similar in both versions of the program. In addition, version 2 files can be opened directly in 

version 3. 

  

The main difference in version 3 is that once several market-system (.msa) files have been 

created, a portfolio can be defined. This is done by opening a new portfolio (.msaport) file, 

then selecting two or more market-system (.msa) files from the Setup window. Once the 

market-system files have been selected, the trade histories are combined by MSA to show the 

resulting portfolio equity curve.  

  

While most features in version 3 pertaining to market systems are the same as in version 2, 

there are a few differences. In version 3, market systems can have entry and exit dates for 

each trade. Exit dates are required for each trade if you want to view results that relate to 

date/time, such as the return each month or year. Entry dates are used primarily to track 

margin usage when multiple trades occur together. When migrating a version 2 file to version 

3, dates can be added in an approximate manner in the Edit/Add Trades window (Trades 

menu) using the Set Date Range button. This enables you to set the dates for each trade based 

on the starting date, ending date, and average trade length for all trades in the history. To add 

the exact entry and exit dates for each trade, either re-import the trade data from a file that 

includes dates or use the Data Source command (Trades menu) to set the trades file to a text 

file that contains the trade data with dates. 

  

When exit dates are available for all trades, the equity curve in the main chart window can be 

plotted either by trade or by date. To change to plotting versus date, version 3 has a Plot by 

Day/Week/Month/Year/Trade pull-down menu selector in the menu bar at the top of the 

window. You can also choose to limit the trade range by date in version 3 using the date 

selectors in the menu bar. After selecting the starting and ending dates, click the Recalculate 

button to recalculate the equity curve for the new range of trades. 

  

Version 3 also allows multiple windows and files to be opened at once. For example, you 

might have several market-system files open as well as a portfolio file. Each file will be 

shown in its own tab. The menus available in the main window frame depend on the type of 
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tab/file selected. When a portfolio file is open and selected, the menus in the main window 

reflect the options available for portfolios, including a Portfolio menu. When a market-system 

file is open and selected, the menus reflect the available options for market systems, including 

the Trades and Analysis menus. Trades are only entered, imported, and edited in market 

systems, not portfolios. To enter or import trades, a market-system window must be selected. 

By default, the files opened when the program was last closed are opened when the program is 

opened from the Windows Programs menu or desktop. 

  

When opening a version 2 file in version 3, the equity curve crossover and dependency 

rules may need adjusting. In version 2, several of the equity curve crossover and dependency 

rules adjusted the position sizing parameter value by a specified percentage based on the rule 

logic. For example, the fixed fraction might have been increased 20% on an equity curve 

crossover. In version 3, the rules change the position size directly, rather than changing the 

position sizing parameter value. Instead of increasing the fixed fraction by 20%, the same rule 

in version 3 will increase the position size by 20%. In some case, this will have the same 

effect as the old rule. However, in some cases, the effect will be in the opposite direction. For 

example, increasing the fixed equity amount is the same as decreasing the position size. When 

working with a version 2 MSA file in version 3 for the first time, each crossover and 

dependency rule should be reviewed and adjusted if necessary to make sure it works as 

desired. 

  

Also keep in mind that while MSA version 3 can read version 2 files, the reverse is not 

true. MSA version 2 cannot read version 3 files, so if you want to be able to continue to 

use a version 2 file in MSA 2, it's important to "save-as" your version 2 file to a different 

name in version 3. Once a version 2 file is saved in version 3, it becomes a version 3 file 

and will not be readable by version 2. 

  

For non-US users, starting with version 3.0.3, you can change the number/currency format 

(locale) from the Setup command to match the currency that your trading account is 

denominated in. For example, if the locale is set to Germany, the currency symbol will be the 

Euro symbol, and the thousands separator will be the "." rather than the "," used in the US. It's 

not necessary to change the Windows locale, as in previous versions. You can select an 

account locale for each market-system file and for each portfolio file. You can also select the 

number/currency format for the trades file. For example, if using the WriteTrades function for 

TradeStation, the number format will be "US". If your account is in Euros, you could select 

Euros in Setup for your account and "$" for the trades file format. The format for the trades 

file is set on the Trades File Format window when using the Data Source command or when 

importing a trades file. Please note: MSA does not include a currency converter. If you have 

market systems with different account locales and you combine these into a portfolio, MSA 

will not convert the currency values from the market-system locale to the portfolio locale. 

However, starting in version 3.2, there is an input data field for currency conversion. The 

value in this field is multiplied by the entry, exit, and stop prices, as well as by the average 

true range (ATR) value. 

  

An important difference in version 3 is how trade data are stored. In version 2, the trade data 

were stored in the .msa file. In version 3, the trade data (entry price, exit price, entry date, exit 

date, position size, etc.) are stored in a separate text file that is specified using the new Data 

Source command of the Trades menu. This new feature is designed to make it easier to update 

and work with trade data files. The Data Source command allows you to specify the file 

where trade data are stored and identify the columns of data that MSA should read. If you edit 

trades within MSA, the trades file is updated accordingly. Likewise, if you change the trades 

file outside of MSA, the market-system file will change the next time it's opened or if you 

select Reload From File from the Trades menu. By storing the trades in a separate trades file, 

several MSA files can reference the same file of trades. If the file is changed, all MSA files 

that use that trades file will automatically reflect that change. Also, any portfolio file based on 

the MSA file will be updated as well. 
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If you import trades into MSA from a text file using the Import  command, the next time you 

save the MSA file, the program will prompt you for a file name for storing the trade data. This 

will be the "trades file" for your MSA file. Any changes made to the trades while in MSA will 

be stored in the trades file. If you want to use the text file from which you imported the trades 

as your trades file, you can save a few steps by using the Data Source command to define 

your trades rather than importing them. 

 

For a complete listing of features and updates by release number, please refer to the Adaptrade 

web site at www.Adaptrade.com, go to the Support link, and click on Release Notes. 

 

Installation 
 

Minimum System Requirements: 

 333 MHz processor 

 64 MB RAM 

  50 MB hard disk space 

 Windows XP operating system 

  

Recommended System Requirements: 

 1.2 GHz processor or faster 

 128 MB or more RAM 

 50 MB hard disk space 

 Windows XP or Vista operating system 

  

 

If you obtained Market System Analyzer (MSA) by downloading it from the web site, the 

downloaded file should be named MSA3-mmddyy.exe, where mmddyy represents the month, 

day, and year of the release; e.g., MSA3-091207.exe. To install MSA, go to the Start menu in 

the Windows task bar and select Run... Browse to the location of the MSA3 file, click Open, 

then click OK in the Run window. The installation should begin. 

 

The installation program will prompt you for the location to install the program files. The 

default location is the folder Program Files\Adaptrade Software\Market System Analyzer 3\. 

You can install the program in another location if you wish. Itôs recommended that you 

uninstall previous versions of MSA 3 before installing newer ones. 

 

Once the installation is complete, you should find the MSA icon on your desktop and the 

MSA program in the programs menu. You should also find a folder called MSA Examples in 

the Market System Analyzer 3 folder. The Examples folder contains sample files of type .msa 

and .msaport and sample text files containing trade data. The Market System Analyzer 3 

folder also contains a web link to the user's guide in PDF format and the TradeStation 

EasyLanguage file WriteTrades32.eld, along with its text file equivalent, WriteTrades32.txt. 

The WriteTrades function (see Chapter 3) allows you to generate a text file of trade data from 

a TradeStation system for use in MSA. 

 

The licensed (paid) version of MSA also includes the TradeStation file PSCalc32.eld, which 

includes the PSCalc TradeStation function (see Appendix). PSCalc implements the position 

sizing methods used in MSA. A sample trading system to illustrate the use of the function is 

also included. 

 

To uninstall MSA, run "Add or Remove Programs" from the Windows Control Panel. 
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Market Systems and Portfolios 
Critical to understanding MSA is the concept of a market system, defined as the combination 

of a market and the trading system or method applied to that market. For example, a trading 

range breakout system applied to T-bonds is a single market system. The same system applied 

to crude oil, or a different system applied to T-bonds, would be a different market system.  

 

A market system is fully represented by the series of trades that results from trading the 

system or method on the market. As long as the list of trades is available, the details of the 

trading system logic and of the underlying market are unnecessary. This is the approach 

adopted by MSA. The list of trades is the fundamental input data required by MSA to define a 

market system. 

 

Prior versions of MSA were limited to analyzing market systems individually. In version 3, 

market systems can be combined into portfolios. Provided two or more market systems have 

been established in MSA, a portfolio can be defined as a combination of market systems. The 

files for the market systems (.msa files) must be saved in order to create a portfolio. Once the 

market-system files are available, a portfolio is created by selecting the existing .msa files.  

 

In a portfolio, MSA automatically combines the trades from the separate market systems as if 

all selected market systems were being traded together in the same account. The program 

accounts for overlapping trades in terms of costs and margin requirements and calculates the 

performance of the overall portfolio. The settings made in the individual market-system files 

are applied to the portfolio. Additional settings can be made for the portfolio overall, and the 

position sizing for each market system in a portfolio can be set within the portfolio file. 

 

Each market system and each portfolio is represented by a separate window in MSA. Both 

types of windows can be open in MSA at the same time. Starting in version 3.2, these 

windows are shown as tabs in MSA. 

 

Understanding the Document Windows 
MSA can work with multiple document windows, as shown below. These windows represent 

the documents opened via the File menu. MSA can work with documents for both market 

systems and portfolios. In either case, a document window is displayed within a tab. Each 

document window contains the main chart, which displays the equity curve and the number 

of shares/contracts for the current sequence of trades using the analysis settings and options 

currently in effect. In addition to the equity curve, the main chart optionally displays a 

moving average of the equity curve and an ñideal equity curve.ò The moving average can be 

used to modify position sizing (see Chapter 5, Position Sizing, Equity Curve Crossovers). 

Below the equity curve is a bar chart for the number of shares/contracts for each trade. The 

number of shares/contracts is determined by the position sizing method selected by the user.  

 

To the right of the document windows is a summary pane, which contains a list of 

performance statistics for the document currently selected. The performance statistics in the 

summary pane correspond to the equity curve and are updated whenever the equity curve 

changes based on the userôs selections. The performance results in the summary pane are an 

abbreviated version of the full performance report, which can be opened by right-clicking in 

the summary pane. 
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Almost everything that happens in MSA is reflected in the document windows. All changes 

and settings made in the program are reflected in the equity curve, in the bar chart for the 

number of shares/contracts, and in the corresponding performance statistics in the summary 

pane. The equity curve and the bar chart are a visual representation of the programôs data 

(the profit/loss sequence) and the analysis options and settings. These settings include the 

position sizing method, which adjusts the number of shares/contracts for each trade, the 

range of trades to analyze, the order of the trades, trade dependency rules, and other analysis 

options. The initial account equity and the slippage and commission costs are also reflected 

in the charts. 

 

A commonly used term in MSA is the "current sequence of trades." The current sequence of 

trades is the set of trades currently under analysis and in the order displayed in the main 

chart. The current sequence of trades may be a subset of the trades originally entered or 

imported via the Trades menu and may be in a different order than the original trades. The 

document window always displays the current sequence of trades. You can change the order 

of the trades in the current sequence using the randomize button on the toolbar or choose to 

restrict the analysis to a range of the original sequence of trades. In either case, this will 

change the "current sequence," although the original sequence, as initially entered or 

imported via the Trades menu, remains unchanged. To see the original sequence at any time, 

use the Edit/Add command (Trades menu). The current sequence can be restored to the 

original sequence at any time by restoring the original trade order and trade range via the 

toolbar. 

 

The document windows in MSA can be modified in a number of ways. The summary pane 

can be resized by clicking and dragging its left border. The two graphs (equity and trade size) 

can be resized in the same manner by clicking and dragging in the horizontal area separating 

the two graphs. Above the main chart, a drop-down menu in the toolbar allows the plotting of 

the equity curve to be switched between ñLinearò and ñLogarithmic.ò Logarithmic plotting is 

useful when position sizing is applied. An equity curve with equal rates of return from period 

to period will plot as a straight line on a logarithmic chart.  
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Clicking on the equity curve will display data for the selected trade in a box that tracks the 

cursor, as well as in the status bar at the bottom of the chart. Using the zoom feature, any part 

of the chart can be magnified and later restored to normal magnification. Lastly, the trade 

range option in the menu bar allows the analysis to be restricted to a range of trades. After 

entering the first and last trades to include in the analysis, click the ñRecalculateò button in 

the menu bar to update the analysis. 

 

Program Conventions 
MSA contains a number of features that are common throughout the program. Many of these 

conventions may be familiar from other Windows programs you already use. Learning these 

program conventions will make using MSA more convenient and efficient.  

 

One such convention is floating menus. In most windows in MSA, including document 

windows and the performance reports, you can right-click anywhere in the window to bring 

up a floating menu with common program commands. Right-clicking in the document 

window over the charts brings up the largest floating menu, which contains commands for 

setup, position sizing, dependency rules, chart formatting, and other common commands. Itôs 

often more convenient to right-click than navigate to the menus in the menu bar. This right-

click menu can be customized using the Customize command (View menu), Menu tab. 

 

Another short-cut in MSA is provided by double-clicking in the document window. Double-

clicking over the chart brings up the Format Chart window. 

 

MSA 3also includes the common convention of copying to the clipboard. Any window that 

contains a floating menu can be copied to the clipboard. For example, the main chart can be 

copied using the copy button in the toolbar, by right-clicking and selecting Copy, or by using 

the Ctrl-C keyboard shortcut. This copies the entire chart image to the clipboard as a bitmap.  

 

The right-hand performance summary pane can be copied by right-clicking in the pane or by 

clicking in the pane to set the focus then using the Ctrl-C shortcut. In this case, the copy 

command copies the text from the pane to the clipboard. The text is copied in tab-delimited 

format so that it can be pasted into a spreadsheet correctly. Similarly, the different 

performance reports can be copied to the clipboard as tab-delimited text.  

 

Another convention in MSA is that the different performance reports in MSA all contain the 

same menus, which include commands for copying, as described above, printing, and saving 

(exporting) to a text file. For exporting, the available formats are tab-delimited text (.txt 

files), comma-delimited text (.csv), unformatted Word documents (.doc), and web files 

(.htm). 

 

Similar to other Windows programs, the menus available in the menu bar of the main 

window of MSA change depending on the type of document currently open and selected. In 

particular, youôll notice that when a market-system (.msa) document is open and active, an 

Analysis menu is present. If you then open a portfolio (.msaport, or .msp) document, the 

Analysis menu will no longer be accessible, but a Portfolio menu will be present. The 

available menus and associated commands are appropriate to the type of document thatôs 

currently active. To see the Analysis menu again, you would simply have to click on the tab 

for a market-system document to make it the active window. 

 

Lastly, MSA uses the Windows help system convention. This means that you can bring up a 

help topic for a command or open window by pressing the F1 key. If a help topic is available 

for that command or window, the help system will be opened with the corresponding topic 

displayed. 
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Data Requirements 
MSA is designed to extract the maximum amount of information from the minimum amount 

of data. Because a market system can be defined by its trades, the only data required by the 

program is a list of profit/losses for the trading system or method you want to analyze. 

Optionally, to apply fixed fractional position sizing, or a variant of fixed fractional called the 

profit risk method, you will also need the risk of each trade. The risk is defined as the dollar 

amount that the trade would lose per contract (share) if it were a loss. Commonly, the trade 

risk is taken as the size of the money management stop applied, if any, to each trade. If your 

trading doesnôt use protective (money management) stops, the risk can be taken as the largest 

historical loss. Trade risks are only used with these two position sizing methods and in the 

calculation of R-multiples. 

 

You may also specify trades in terms of the entry and exit prices, along with the trade 

direction ï long or short, instead of the profit/loss itself. For example, if a stock was bought 

at a price of 52 and sold at a price of 54, the profit/loss would be $2 per share. If you traded 

100 shares, the total profit/loss would be $200. You can either enter $200 as the profit/loss, 

with a trade size of 100 shares, or enter the entry and exit prices of 52 and 54. Optionally, the 

stop price can be entered in place of the risk. If, for example, a sell stop was placed at a price 

of 49, the trade risk would be 52 - 49 or $3 per share. Alternatively, the stop price of 49 

could be entered.  

 

Each trade can optionally include the date and time for the entry and exit. For the purpose of 

constructing the equity curve, the exit date/time is used; i.e., the equity is accumulated when 

the trade is closed out. Entry dates/times are used primarily to determine the cost and margin 

requirements of open positions.  

 

The Trade menu provides the commands needed to work with trade data in MSA. There are 

several methods of entering the trade data into the program. Trade data can be read from an 

existing text file specified via the Data Source command, imported through the Import 

command, or entered manually through the Edit/Add command. An optional fourth method 

allows you to create a series of trade profit/loss results based on the statistical properties of 

the trades (see Chapter 3, Input Data, Creating Trades from Statistics). This method 

randomly generates a series of trades based on the average profit, average loss, maximum 

profit, maximum loss, and percentage of winners. See Chapter 3, Input Data, Gettting Data 

into the Program. 

 

If the trade risk value is the same for all trades, the Specify Trade Risks command of the 

Trades menu can be used to set the trade risk for all trades to one of the following values: the 

largest loss, maximum loss, average loss plus N standard deviations, or a user entered value. 

 

Trade data are only entered for market-system documents, not portfolio documents. If a 

portfolio document is active, the Trades menu will not be available. To work with the trade 

data in a portfolio, open the market system containing the data and work with the data in the 

market-system document. 

 

When a market-system document is saved as a .msa file, the trade data are saved in a 

separate trades file, which is listed under the Data Source command. With regards to trade 

data, the .msa file only saves the name of the trades file. Using the Save command saves both 

the .msa file and the trades file. 
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Examples 
To demonstrate how to get started with Market System Analyzer (MSA), there are several 

sample data files provided with the installation. These files can be found in the MSA 

Examples folder of the installation folder, which is typically Program Files\Adaptrade 

Software\Market System Analyze 3\. The files include market-system files (extension .msa), 

a portfolio file (.msaport), and the trades files (.csv) read by the market-system files. 

 

To open the samples, use the Open command of the File menu, navigate to the Examples 

folder, select all available .msa files, and click the Open button. Open the portfolio file using 

the same command by changing the file type selector to Portfolio Files (.msaport, .msp) and 

selecting the .msaport file. 

 

The file Example1.msa is a stock trading example. Click the documentôs tab to make it the 

active document, as shown below. 

 

 
 

Go to the View menu and select Equity Table. With the Equity Table still open, try clicking 

the Randomize button in the toolbar. Randomizing a sequence of trades can be an effective 

way to learn how the order of the trades affects trading performance. Also, by randomizing 

the sequence, we can determine if our performance expectations depend on a particular 

ordering of the trades that may never reoccur. When you randomize the trade order, the chart 

should redraw with the trades in a different order, and the results to the right of the chart 

should show the corresponding performance for the new sequence of trades. Also, you 

should see the order of the trades in the Equity Table change to match the order in the chart. 

Now restore the trades to the original order by clicking the Restore button in the toolbar. 

 

Now go to the Analysis menu and select the Setup command. On the Account Settings tab, 

enter a value of $5,000 for the starting account size and click OK. The chart will update to 

reflect the new account size. Now choose Position Sizing from the Analysis menu and select 

"Fixed Amount of Equity" from the Position Sizing Method tab. Enter an equity amount of 

$20,000 per unit. Where it says ñWhen plotting, use parameter values froméò, make sure 

the first option in the drop-down list (ñUser entriesò) is selected. Click OK. The chart should 
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redraw with the new position sizing method, which should be indicated in the summary pane 

to the right of the chart. Now go back to the Position Sizing window and return the position 

sizing to ñFixed risk (aka fixed fractional).ò 

 

Try running a Monte Carlo analysis by pressing F4 (function key) or selecting the Monte 

Carlo Analysis command from the Analysis menu. This will bring up a window displaying 

the Monte Carlo analysis results. Now press F1 or click on the Help command on the results 

window. This should bring up a help window with information on the results window. In 

general, pressing F1 brings up a help topic for the command currently selected or the window 

currently displayed. 

 

 

 
 

To see how the Parameter Studies command works, press F5 or select the Parameter 

Studies command from the Analysis menu. On the y axis pull-down menu, select ñMax % 

DD.ò On the x axis, select Fixed Fraction. Enter 10 in the box labeled "Max X Value" and 

click on the PLOT CURVE button. The plot should appear as shown above, where the 

drawdown increases with increasing values of the fixed fraction. Try changing the y axis 

parameter and plotting the curve again. Now try selecting "Monte Carlo Analysis" in the box 

below the chart labeled "Calculate Y values using." The plot should take much longer to plot 

because each point requires a Monte Carlo analysis. 
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Close the Parameter Studies window and select the Optimize Position Sizing command 

from the Analysis menu (F7). The Optimize Position Sizing window will appear, as shown 

above. Select Net Profit as the performance measure to maximize, check the "Limit max 

percent drawdown..." box, and enter a maximum drawdown value of 20%. Optimize over all 

trades in the current sequence and optimize using the current sequence of trades (as opposed 

to Monte Carlo analysis). Now click the calculate button. The optimal results will appear in 

the bottom part of the window. You should find that the optimal value of the fixed fraction is 

3.12%. The worst-case drawdown at this value is 19.8%, matching our drawdown limit of 

20%. 

 

Close the Optimization Results window and right-click in the summary pane or select 

Performance Results from the View menu. This will open the performance results window. 

Try the different tabs. The Settings tab displays the program settings under which the results 

were calculated. The Summary tab displays the results in summary form, including separate 

columns for long and short trades, if applicable. The Return Tables tab presents the results 

for annual, monthly, weekly, and daily periods. There are also tabs for the dependency and 

significance test results. The settings for the significance test are made on the Options tab of 

the Analysis Setup window (Analysis menu). Lastly, try different dependency rules using the 

Dependency Rules command and see how they affect the performance results.  

 

Letôs move to the portfolio example. Click on the tab for the document 

PorfolioExample.msaport. Now right-click on the chart and select Setup from the floating 

menu. The Market Systems tab displays the market-system files that compose the portfolio. 

You should see three market-system files. If you double-click on a file in this list, the 

market-system file will open in its own window. You can also use this window to add 

additional market systems or remove existing market systems from the list.  

 

Now select the Settings tab of the Portfolio Setup window. This is where you enter the 

starting account size for the portfolio, as well as basic settings for the portfolio Monte Carlo 

analysis, dependency analysis, and significance test. 
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The position sizing for the portfolio is set for each market system individually. When a 

portfolio is initially constructed, the position sizing method and parameter values for each 

market system are retrieved from the market-system file. To set the position sizing to 

different values, select the Position Sizing command of the Portfolio menu. This opens the 

Portfolio Position Sizing window, as shown below. 

 

 
 

To change the position sizing settings for any market system, either double-click on the 

market system in the list or select from the list and click the Edit Selection button. To set the 

position sizing for all market systems to the same method and/or parameter values, click the 

Set All button. 

 

The Portfolio menu is similar to the Analysis menu for market-system documents. Most of 

the analysis functions available for portfolios are listed in the Portfolio menu, including 

dependency rules, Monte Carlo analysis, and optimizing position sizing. These commands 

are also available in the floating menu by right-clicking in the chart area. 

 

The best way to learn MSA is to try things. Select a list of trades from your favorite system 

or trading method using Data Source, and try the various analyses. If you have questions 

along the way, try pressing F1 to bring up the associated help topic at any time. Also try the 

FAQ (Frequently Asked Questions) list of the help system or search for a help subject 

using the help index. 



Chapter 3 
Input Data 

 
 
 

Getting Data into the Program 
All analyses in Market System Analyzer (MSA) are performed on data representing the trade 

history of a trading system or discretionary trading method. The easiest way to supply the 

required data to MSA is to specify a text file of trade data via the Data Source command of 

the Trades menu. Alternatively, the data may be imported from a text file or entered 

manually via the editor; see Editing Input Data below. 

  

The format of the trades file is the same whether imported or specified via Data Source. The 

basic format is a text file with one trade per line. Each column in the file will contain a 

different data field, such as the profit/loss, entry price, exit price, trade size, etc. The simplest 

such file would contain a single column of the profit or loss for each trade. A typical text file 

of profit/loss data for MSA is shown below. 

 

 

 300.00   

 -250.00   

 500.00   

 175.00   

 -425.00   

 -300.00   

 350.00 

 ...  

 ... 

 

For example, the first trade was a profit of $300.00, and the second trade was a loss of -

$250.00. The third trade was a profit of $500.00, and so on. A more complete trades file 

might look like the spreadsheet shown below. Each line contains the data for one trade: entry 

date/time, entry price, exit date/time, exit price, stop price, trade direction, profit/loss, trade 

risk, and position size. 
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MSA can read the data fields listed in the following table. 
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Data Field Description Examples/Acceptable 

Formats*  

Profit/loss Trade profit or loss in 

dollars 

Profit: 400.25,  $1,025.64 

Loss: -325,  (325)  

Risk Trade risk in dollars Same as Profit/loss 

Trade size Number of shares or 

contracts 

corresponding to 

profit/loss and risk 

2   1000   25,028 

Sign (+/-) indicates 

long/short if no trade 

direction column. 

Entry price Price at which trade 

was entered 

1204.25   54.37 1,189.75 

Exit price Price at which trade 

exited 

Same as entry price 

Stop price Price at which money 

management stop was 

placed 

Same as entry price 

Entry date Date/time at which 

trade was entered 

3/29/2007 

12/10/2005 11:00 AM 

(Standard Windows date 

formats, interpreted by 

locale setting.) 

Exit date Date/time at which 

trade exited 

Same as entry date 

Trade 

direction 

Whether trade was 

long or short 

Long trades: long, Long, 

LNG, L, Buy, C (for 

ñcompraò), 1 

Short trades:  short, Short, 

SHT , S, Sell, V (for 

ñventaò), -1 

Symbol String representing 

market 

ES, MSFT, GPB, Index1 

ATR Average true range Same units as price. 

Currency 

Conversion 

Factor multiplied by 

prices and ATR 

Numeric. Defaults to 1.0 

if not specified. 

Trade Type Indicates regular 

trade, cost/fee, or 

addition/withdrawal 

R or 0 for regular trade; C, 

F, or 1 for cost/fee; 

A or 2 for add/withdraw 

amount; P or 3 for 

add/withdraw percentage 

of equity. 

*Interpreted based on selected locales. 

 


























































































































































































